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OneCNC Mill Multi-Axis

This manual covers the optional 4 Axis and 5 Axis machining modules 
which can be added to OneCNC Mill Professional and Mill Expert.  
These modules provide powerful yet easy to use modes which help 
you program parts quickly and reliably for multi-axis machining 
centers.

The purpose of this Manual

This manual is designed to get you started with OneCNC multi-axis 
toolpathing, so you can begin creating your own toolpaths as soon as 
possible.

Multi-axis machining is an advanced subject.  You should have a 
working knowledge of 3 Axis toolpathing and construction planes in 
OneCNC before you start Multi-axis toolpathing.

The subjects covered are not machine specific and for operational 
methods and settings you should consult the instruction manual for 
your machine.
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OneCNC Multi-Axis Modes

The modes made available by each OneCNC module are:

4 Axis Module
4 Axis Position
4 Axis Simultaneous
4 Axis Wrap

5 Axis Position + 4 all Module
5 Axis Position
4 Axis Position
4 Axis Simultaneous
4 Axis Wrap

5 Axis SImultaneous Module
5 axis Simultaneous

Note: 

The 5th Axis Position + 4 all Module must be present before the 5th 
Axis Simultaneous module can be added.
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Multi-axis machining mode selection

At the top of the NC Manager the icon 
next to the Process icon shows the 
current multi-axis mode.  Clicking 
on this icon will open the Multi-axis 
selection dialog.

Select the multi-axis mode you want to use.  The image in the Multi-
axis selection dialog indicates the type of machining selected.

For the 4 Axis Wrap and Simultaneous modes, you can select the 
machine axis the 4th axis is aligned with.

For the 4 Axis Wrap mode, text boxes will appear for the input of 
values for Material Diameter and Length.

The multi-axis icon in the NC Manager will change to indicate which 
multi-axis mode is currently selected.

 
Note: 
The modes available depend on the module you have licensed. 
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Before any modules are activated the only modes available will be:

3 Axis

Normal 3 axis environment.  This is the default mode.

3 Axis Reposition

The 3 axis reposition mode simplifies the process of creating 3 axis 
toolpaths which are to be machined in different positions.

Adding the 4 axis module will activate these modes:

4 Axis Position

3 axis toolpaths on a stock with a rotation angle for the 4th axis. 
Defined on a plane at this angle. 

4 Axis Full

A 3D model method which will mill a shape in incremental passes as it 
is rotated on the 4th axis.

4 Axis Wrap

Applies 3 axis stock or model toolpaths to the circumference of a 4 
axis part.

Adding the 5 axis Position module will activate this mode:

5 Axis Position

3 axis toolpaths defined on a plane with rotation angles for the 4th 
and 5th axes.

Adding the 5 axis Simultaneous module will activate this mode:

5 axis Simultaneous

Toolpaths which can move up to 5 machine axes at the same time.



Page 6 Introduction to OneCNC Mill Multi-axis ©

Multi-axis Position Planes

For 4 and 5 Axis Position toolpaths, it is not necessary to rotate the 
part in the OneCNC model.

To simplify the toolpath definition, the Planes dialog is used to define 
a plane on the part, and the toolpath is defined relative to that plane.

When the part is machined it will rotate to the position the plane 
represents.

When editing a toolpath, the plane used when the toolpath was 
defined is automatically recalled so you do not have to change the 
plane you are working on when the edit is made.

Note:
4 Axis Full and 4 Axis Wrap toolpaths do not use position planes.  
The Angular range of the toolpath is specified in the toolpath wizard 
settings.

The toolpath plane is fixed in space when the toolpath is defined, so 
once you have started programming a model it must not be moved, 
as the plane will not move with it.

For more information, see ‘Precautions for multi axis toolpaths’ in  
OneCNC Help > OneCNC Mill > Mill Multi Axis Machining.
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Multi-axis parts can become complex, but there are some simple 
strategies you can follow to make the process easier.

As OneCNC uses planes for toolpath positions, you will need a plane 
defined for each position.

You will find your work is quicker and easier if you make a habit of 
defining and saving the planes you need at the outset.  This way you 
can return to the exact plane used for a toolpath at any time. 

Having a set of saved planes allows you to easily create the toolpaths 
for each tool in the actual order of machining.
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Multi-axis Layers

Machine Layers

OneCNC can display a model of your machine in the toolpath preview.  
Layers 1 to 5 and the DMG_AXIS4 layers are used for machine preview, 
and should not be used for part modelling or geometry.  Use Layer 3 for 
the body of the machine, Layer 4 for the 4th axis rotary or trunnion, and 
Layer 5 for the 5th axis table.

It is good practice to keep these layers turned off while defining 
toolpaths.  As well as making the part model easier to see, having these 
layers off will reduce the processing time for Hole Feature Recognition 
and Model toolpaths.

STOCK Layer
For an accurate simulation if you are machining a casting or pre-
machined stock you can create a solid model for the simulation stock.

Create a layer named STOCK, then create one or more solids on the 
STOCK layer.  As well as being useful for multi-axis operations, this 
means you can model clamps, fixtures and machine parts and they 
will be included in the simulation view.

You can program your part without the machine model in your part 
file, and then use the File Merge command to include the machine 
model file to check clearances.
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Multi-axis post settings

There is a  Multi-axis tab in the NC Post Settings dialog.

It is essential that the settings in this dialog are correct for your 
machine.

These settings directly affect the NC output and must not be changed 
without a sound knowledge of posting formats and the requirements 
for your machine.
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The axis ranges determine how far the rotary 
axis can rotate in each direction.

The other settings are determined by the 
Post requirements for your machine.

If your machine has the 4th axis aligned with 
the X or Z axis, select the ‘4th Axis Around X’ 
option.

If your machine has the 4th axis aligned with 
the Y axis, select the ‘4th Axis Around Y’ 
option.

For details of Multi-axis Post settings, see the NC Post and Properties 
topic in the Mill NC Post and DNC Settings section of OneCNC Help.

The Multi-axis Post Settings topic in the Mill Multi-axis Machining 
section has additional information.

For 4th axis wrap programming the part must be on the X axis in 
OneCNC.

When you select the multi-axis machining mode, match the Axis of 
Rotation setting to the axis the 4th is aligned with on your machine.

This setting combined with the correct 4th Axis Around setting in 
the post will produce the correct output for your machine.
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This tutorial is intended for OneCNC Mill Expert or Mill Professional with 4 
Axis or 4 & 5 Axis modules activated.

Open the sample file ‘mill expert 4 axis.ONECNC’, and save a copy as 
‘Tutorial 4 axis position.ONECNC’  Note the position of the rotary axis 
which is on the X axis.  The degrees of rotation for this axis will be 
written as the A axis degree values in the NC file.  

Open the layers tab to see how the part file is arranged.

The layer named 3 holds the machine 
body which does not move in the 
preview mode.  The layer 4 holds the 
rotary table, and the part is on the 
model layer.

A model of the casting to be 
machined is on the STOCK layer, 
which Mill Expert uses to define the 
simulation stock.  The remaining 
layers contain boundary geometry for 
the toolpath definitions.  

OneCNC 4 Axis Position Machining
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Preview the example toolpath group and observe the full machine 
simulation in action.

Select show axis simulation in the toolbox, and you will see the 4th 
axis rotates to each position as it is required.  

Return to the part environment and we will begin recreating the 
operations you have just observed.

Before continuing, turn off layer 3 and 
layer 4, so the machine model is not 
visible.
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Creating work planes

The part model does not have to be moved to create 4th axis position 
toolpaths.  The required positions are defined by a construction plane 
at the required angle.

The plane used must be tangential to an imaginary cylinder centered 
on the X axis.  The toolpaths created in this mode will then rotate the 
part to the orientation of the construction plane when it is machined.  
To simplify the toolpath clearance settings the plane is regarded as Z0 
when the toolpath is created.

The first step for creating toolpaths in positions rotated on the X 
axis is to define the planes required.  While working on a part, you 
may need to return to a plane a few times as you define various 
operations.  It is good practice to save all the planes you need before 
you start defining toolpaths.

To create a plane for the first position, 
open the Planes dialog, and click on 
Create plane from points.

Click on the endpoint at the lower left of 
the face as shown.

This point will be the origin of the new 
plane.
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Click on the opposite corner to set the X 
direction of the plane.

Click on the corner shown to set the Y 
direction of the plane.

The plane will now be created on the 
surface.

To save the plane, open the Planes 
dialog and click on the Save icon.

Enter Position 1 for the plane name, and 
click OK.
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Working anticlockwise around the part, 
use the Plane from points command to 
create a plane on the adjoining small 
surface, and save it as Position 2.

To create the third plane, click on the 
Plane from surface icon in the Planes 
dialog.

Click on the lower face to create the 
plane.
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The plane is created but when using 
the Plane from surface method the 
orientation of the plane is dependent on 
how the surface was constructed.

In this case the positive side of the plane 
is facing the part.

Open the Planes dialog and click on Flip 
Plane to correct the orientation of the 
plane.

Save the plane as Position 3.

Create a plane on one of the flats at the 
bottom of the part and save it as Planar 
Finish Lower.



Page 17Introduction to OneCNC Mill Multi-axis ©

Create a plane on one of the flats at the 
top of the part, and save the plane as 
Planar Finish Upper.

Select Position 1 as the current plane 
before proceeding.

Preparing for machining operations

Create a new toolpath group to re-
create the toolpath operations in, and 
rename the Description in the Process 
dialog to Practice Toolpath Group.

You can click on the icon next to 
the example Toolpath Group #1 to 
collapse it.
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The axis mode icon should show that 
the 4 Axis Position machining mode is 
active.

Turn on the blanking surfaces and 
boundary face 1 layers.

You will now have an unobstructed 
view of the part, ready for a toolpath 
definition with a boundary on the first 
face and blanking surfaces covering the 
holes.

We will begin by showing how the Planar 
Finish model toolpath can be used with 
the blanking surfaces to create a facing 
operation.

Note: 

Because the blanking surface and model surface are coplanar, they 
may display with an interference pattern.  This is an effect of screen 
rendering only, and will not affect the toolpathing process. 
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Facing

Click on the Model toolpaths icon, and select Planar Finish.

In the Select Tool dialog, select the 25MM CARBIDE END MILL tool, 
and set Feedrate manually to 1000, and Plunge Rate to 100.
Click Next to continue.
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In the Clearances dialog, the Z levels for the toolpath are defined.  
These levels are all relative to the active plane.

Select Start and Finish Clearance and set it to 150.  This will ensure 
the tool is high enough to clear the part as it rotates while indexing.  

Set the Rapid Z Plane to 50, and Plunge clearance to 5.  Click Next to 
continue.
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To make the Planar cut toolpath act as a Facing toolpath, enter 0 for 
Toolpath angle, Zigzag minimum clearance and Leave for finish.

Select the Zigzag option for direction, and select Constant stepover 
with a stepover value of 10.



Page 22 Introduction to OneCNC Mill Multi-axis ©

For the Boundary type, select the Picked option.
Select None for tool placement, which allows the cutter centerline to 
travel up to the boundary.

Clear the Automatic Z Offset checkbox.  Set Z Top to 10, and Z 
Bottom to 0.  Click Finished to end the toolpath input stage.

For the toolpath boundary, select the 
rectangle on the boundary face 1 layer, 
which is at the edge of the blanking 
surface.

Right click to end the boundary selection and the Planar Finish 
toolpath will be created.
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Right click on the new operation and select Preview toolpath. 

Click  on the Axis simulation icon in the Live Preview toolbox to 
activate axis simulation.  The model will rotate into the required 
position before the milling starts.

Close the Live Preview window when you are ready to continue.

To prepare for milling the next face, 
turn off the boundary face 1 layer, 
and turn on the boundary face 2 
layer.
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Select the Position 2 plane.

Select the Planar Finish toolpath again.

This toolpath will use the same settings as the previous toolpath, so 
you can click through the dialogs of the wizard without making any 
changes, and click Finished to close the toolpath wizard.

Select the boundary on the narrow face 
to define the new toolpath.

Right click to end the boundary selection 
and the Planar Finish toolpath will be 
created.
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We will now define a Planar Finish toolpath for the third face in the 
same way as the first two were done.

To show the boundary for the third 
face, turn on the boundary face 3 
layer, and turn off the boundary face 
2 layer.

Select the Position 3 plane.
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Select the Planar Finish toolpath again.

Click through the dialogs of the wizard without making any changes.  
Click Finished to close the toolpath wizard.

Select the boundary on the third face to 
define the new toolpath.

Right click to end the boundary selection 
and the Planar Finish toolpath will be 
created.

Preview the three facing toolpaths before continuing.
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Hole operations

The next toolpaths to define are the hole operations.
Hole feature recognition can recognize circular holes in models or 
geometry, but the large circular bores will be filtered out as they do 
not have a circular base.  We will use geometry for the Hole feature 
recognition.

Turn off all layers except the model 
layer.

Create two new layers and name 
them Holes position 1, and Holes 
position 3.

Select Holes position 1 as the current 
layer.

Click on the Model Tools icon in the toolbox and select Extract surface 
edges.

Click on the position 1 surface to extract 
an outline of all the edges to the Holes 
position 1 layer.
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Change the active layer to Holes 
position 3.

Click on the position 3 surface to extract 
an outline of all the edges to the Holes 
position 3 layer.

We will begin on the first face, so select 
the Position 1 plane.

Turn off the model layer so you can see 
the geometry clearly.
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Click on the Drill Hole Wizard icon in the Stock toolpaths menu.

Select the 50.8mm hole for machining.
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Select Start and Finish Clearance and set it to 150.  This will ensure 
the tool is high enough to clear the part as it rotates while indexing.  

Set the Rapid Z Plane to 50, and Plunge clearance to 5.  Click Next to 
continue.

The Material Top is 0, which is the Z0 of the position plane.
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Click the Drill icon to add a drill operation to the Hole Operations list.

Double click on the Drill operation to enter the settings for it.
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The first step in defining the Drill operation is to select the 8mm Drill 
from the Tool Library.

Enter Tool number 11, and set Coolant to No1 and Work Offset to 
G54.

Select Aluminium Billet from the Material List to set the feedrates and 
spindle speed.

Click Next to continue.
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Select Automatic drilling and Absolute depth style.

Enter a Z depth for the hole of -44.  This is the depth relative to the 
plane.

Click Next to continue.
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Select the Peck option of the Automatic drilling method, with a Max 
Peck Amount of 3.  Click Finished to complete the Drill definition.
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Add a counter bore operation to the Hole Feature definition list.

Double click on the counter bore operation to enter the settings for it.
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In the Select Tool dialog, select the 25MM CARBIDE END MILL tool.

Enter Tool number 1, and set Coolant to No1 and Work Offset to G54.

Select Aluminium Billet from the Material List to set the feedrates and 
spindle speed.

Click Next to continue.
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Select the Helix method and enter a diameter of 50.8.

Select Absolute depth style and enter a Z depth for the hole of 
-44.45.

Click Next to continue.
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In the Helix settings dialog, set Leave for finish to 0, and Depth per 
turn to 5.  Click Finished to return to the Hole Feature dialog.
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Save the operations to complete the 50.8 hole as ‘50.8 predrill and 
bore’ before clicking Finished.



Page 40 Introduction to OneCNC Mill Multi-axis ©

The drill and counterbore operation will 
be seen in the instant preview.

To bore the other 50.8 hole, select the 
Position 3 Plane.

Start Hole Feature Recognition and 
select the 50.8 hole in the Select 
Features dialog.

Apply the ‘50.8 predrill and bore’ 
definition to machine the bore using the 
same settings as the first hole.
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To drill the 6.35mm holes in position 3, start the Drill Hole Wizard 
again and select them in the Select Features dialog.
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Use the same clearances as for the previous hole operation.

Click Next to continue.
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Add a drill operation and double click it to define the settings.

The settings will be similar to the 8mm drilling we defined earlier, but 
select the 6mm drill from the tool library and edit the diameter to 
6.35.  The depth will be -17.

Save the settings as ‘6.35 drill Z-17’, and click Finished.
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The drilling will be seen in the instant 
preview.

Change to the Position 1 plane, and start 
the Drill Hole Wizard again.

Apply the ‘6.35 drill Z-17’ hole definition 
to the four holes in Face 1.

Next we will define Planar Finish 
toolpaths at the top and bottom of the 
outer surface of the part.

Before continuing, turn on the model 
layer and activate the plane on the 
bottom of the part which you saved as 
Planar Finish Lower.
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Planar finishing

Select the Plane option from the view menu so you are looking 
directly at the plane.

Create a layer named boundary planar, and draw a rectangular 
boundary for the toolpath as shown.

You can use grid snaps to place the corners of the rectangle near the 
fillet vertices.

Click on the Model Toolpaths icon and select Planar Finish.

For parts that require a precise boundary you can extract edges 
from the model and project them to the plane if necessary.
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Select the 6 MM CARBIDE BALL MILL tool.

Enter a Spindle speed of 2000.

Set the Feedrate to 1000 and the Plunge feed to 500.

Click next to continue.
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Select Start and Finish Clearance and set it to 150.  This will ensure 
the tool is high enough to clear the part as it rotates while indexing.  

Set the Rapid Z Plane to 50, and Plunge clearance to 5.

Click Next to continue.
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Enter 0 for Toolpath angle, Zigzag minimum clearance and Leave for 
finish.

Select the Zigzag option for direction, and select Constant stepover 
with a stepover value of 1.5mm.

Click Next to continue.
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For the Boundary type, select the Picked option.
Select None for tool placement, which allows the cutter centerline to 
travel up to the boundary.

Set an Automatic Z offset of 1 and click Finished.
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Select the rectangle as the boundary for the toolpath.

Right click to end the selection process and the toolpath for the lower 
section of the outer shape will be created.
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Activate the plane on the top of the part, 
which you saved as Planar Finish Upper.  

Change to the Plane view again and 
create a Planar Finish toolpath for the 
upper section in the same way as you 
did for the lower section.  
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Preview the toolpath group to see the toolpaths you have defined.

In this position tutorial, we were able to complete most of the 
toolpaths for the part using 4 axis position toolpaths.

The remainder of the part requires the use of the 4 axis simultaneous 
method.  This will be covered in the next tutorial.
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This tutorial is intended for OneCNC Mill Expert or Mill Professional with 4 
Axis or 5 Axis modules activated.

The remaining toolpath for this part is the 4 Axis simultaneous 
toolpath around the outside of the part.  Open the file you used for 
the 4 axis position tutorial, and save a copy as ‘Tutorial Multi 4 axis 
simultaneous.ONECNC’.

Click on the axis 
selection icon and 
select the 4 axis 
Simultaneous mode.

The part is aligned on 
the X axis, so select 
the X option for Axis 
of Rotation.

The 4 axis Simultaneous icon will be shown on the NC 
Manager toolbar.

OneCNC 4 Axis Simultaneous
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Part analysis 

Select the default XY plane.  The current plane does not affect 4 axis 
simultaneous toolpaths, but we need to know the angular range we 
want to apply it to.  We can get the values from an extracted edge.

With the ‘boundary planar’ layer active, click on Model Tools icon and 
select Extract an edge.

Click on an outer edge of the model 
as shown, and right click to end the 
command.

Turn off the model layer so you have a 
clear view of the extracted geometry.

Click on the Verify single entity icon in 
the Verify toolbar.

Click on the arc segment of the 
extracted edge.
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The Verify panel shows the Start Angle is 
197.65 and the End Angle is 342.35.

It is important to remember the angle is 
measured anticlockwise from vertical.

The external radius of the part is shown 
as 50.8.  

To find the X axis range of the part, 
turn on the Model layer and click on the 
Verify endpoint icon in the Verify toolbar.

Click on a vertex at the X+ side of the 
part.

The Verify panel will show the side is at 
X76.2.

Now that we know the angular and X axis range for the toolpath, we 
can continue with the toolpath definition.
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Define a 4 axis Simultaneous toolpath

Click on the Simultaneous toolpaths icon and select 4 Axis Machining.
In this mode other strategies are not applicable.

Select the 6mm Ball Mill used for the Planar Finishing.

Enter a Spindle speed of 2000.

Set the Feedrate to 1000 and the Plunge feed to 500.

Click next to continue.
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In the 4 axis Options dialog, select the Across Model cut method.  
Select the Zigzag Toolpath check box.

Set X Start to -3 and X End to 79.2, to allow the cutter to fully round 
the fillet.  Enter a Clearance radius of 55, Material Radius of 50.8, and 
Surface Tolerance of 0.01.  Set Leave for Finish at 0.

Enter a Maximum Stepover of 1.5, and the Incremental Angle will 
update automatically, as these two settings are related.  The Start 
Angle can be rounded to 198, and the End Angle to 342.  

Click Finished to create the toolpath.

The toolpath is applied to the angular 
range between the flats.
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Preview the completed toolpath group to confirm the settings.
The programming of this part is now complete.

A tip for faster part simulation

For parts with a very fine surface finish, enter a coarser stepover 
than you actually require when you first define the toolpaths.  
Toolpath simulation or preview will run quicker.

When the toolpaths are complete, edit the stepover to the fine 
setting you actually require before the final check and output of the 
NC file.
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This tutorial is intended for OneCNC Mill Expert or Mill Professional with 4 
Axis or 5 Axis modules activated.

4th axis wrap machining applies toolpaths around a cylindrical surface 
on a part.  In this tutorial we will use 4 axis wrap to engrave some 
text on the part used in the previous 4 axis tutorials.

Open the file, and save a copy as ‘Tutorial Multi 4 axis wrap.ONECNC’.

OneCNC 4 Axis Wrap
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Click on the axis selection icon and select 4 axis Wrap mode.
Enter 76.2 for Material Diameter and 76.2 for Material Length, and 
click OK.

The 4 axis Wrap icon will be shown on the NC Manager 
toolbar.

When you enter 4 axis wrap mode you will see a virtual grid on the XY 
plane which represents the unwrapped material cylinder.  The X length 
of the grid is the Material Length.  The Y length is the circumference 
of the Material Diameter.  2D geometry or 3D surfaces for wrap 
machining should be located within this grid.
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The grid position in Y is determined by the 4th Axis Wrap range set 
in the Multiaxis tab of the post settings.  The default range of -180 to 
180 will put the grid in a range from -Y to +Y.

We can accurately position our engraving by using geometry created 
by unwrapping a cylinder.  The unwrap function creates geometry in 
the range of 0 to 360 so we will set the post to match that range.

Open the NC Post Settings and select 
the Multiaxis tab.

Set 4th Axis Wrap Min to 0.
Set 4th Axis Wrap Max to 360.

The grid will move to the unwrap cylinder range.
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Create reference geometry

Create a layer named Unwrap.

Click on the Model Tools icon and select Unwrap cylinder.

Click on the recessed cylindrical surface of the solid model.

A developed outline of the surface will be created.
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Turn off the model layer so you have a clear view of the geometry.

If you switch to CAD or Top View now, 
the view will be aligned with the X axis 
horizontal as shown.

To make it easier to place the text we 
want to machine, we will create a plane 
to suit the orientation of the developed 
cylinder.

Click on the ‘Create plane from points’ 
icon in the Planes dialog.
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Pick the top left endpoint of the unwrap 
rectangle to define the origin of the 
plane.

Pick the lower left endpoint of the 
rectangle to define the X direction of the 
plane.

Pick the top right endpoint of the 
rectangle to define the Y direction of the 
plane.
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Save the plane you have just defined as Unwrap plane.

Select the Plane option from the View Menu.

The view will rotate so the rectangle is horizontal.

Zoom in on the rectangle using the Zoom window command.
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Create geometry to machine

We are now ready to place the text which we want engraved on the 
cylindrical face of the part.  Create a new layer named Text and make 
it current before proceeding so the text outlines can be isolated for 
the Engrave All - Constant Z function.

Click on the Text icon in the toolbox and select the Text command.

Click on the Font Attributes button in the Enter 
Text dialog.

Select Truetype Fonts, pick Verdana from the Font dropdown list, and 
select the Bold check box.  Set the Height to 13.  As we are working 
on a plane aligned with the rectangle, we can leave Angle at 0.

Click OK to return to the Enter Text dialog.
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Select Center Alignment.
Type ‘OneCNC’ in the Enter Text dialog, and click OK.

Place the text entity in the rectangle.
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Click on the Text icon in the toolbox and select the Text to geometry 
command.

Click on the text entity to convert it to machinable geometry.
If you want to adjust the placement of the text outlines, use the 
selection box for the Text layer in the Layer Manager to select the 
geometry, and move it using the sketch position option.

Turn off the Unwrap layer so only the vectorized text is visible.

Before continuing, check that the 
Practice Toolpath Group is active, and 
that the 4 axis wrap icon is showing in 
the NC Manager toolbar.
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Define a Wrap toolpath

Click on the Stock Toolpaths icon and select the Engrave all 2D 
toolpath.

Click on the tool image in the Select Tool dialog, and select the 1mm 
Ball mill from the Tool List.
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Set the Start and Finish Clearance to 150, the Rapid Z Plane at 50 
and Plunge clearance to 1.

Enter a Final Z of -0.5.
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The Path Creation settings allows you to mill geometry to the full 
depth in more than one pass.

As we are only engraving in this example select None for the Toolpath 
style. 

Click Finished and the toolpath will be created.
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Right click on the toolpath group and select Simulate/Rest.

Select the Stock Model option.



Page 73Introduction to OneCNC Mill Multi-axis ©

After the main part machining, you will see the text geometry 
engraved  around the cylindrical surface.

An engraving tip

For small text, a single line shx font such as _romans will be clearer 
and take less time to cut.

When engraving larger text, a bold TrueType font will give a better 
result as the separation of the outlines is more distinct.  
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This tutorial is intended for OneCNC Mill Expert or Mill Professional with the 
5 Axis position machining module activated.

There are two main types of machines OneCNC 5 axis position 
machining can be used to create NC programs for.  

There are those with a trunnion operated 
by the fourth axis, which holds a rotary 
table controlled by the fifth axis.

This is the sample file ‘5 axis position 
trunnion.ONECNC’. 

The other type has a fifth axis rotary 
table mounted on a swivel table 
rotated by the fourth axis, which is not 
necessarily horizontal.

This is the sample file ‘5 axis position 
dmg.ONECNC’ which is for the same part 
on a machine with a swivel table.

In this tutorial we will work with the trunnion style sample, but as the 
OneCNC 5 axis position programming method is the same, you can 
complete this tutorial working on the sample part most suited to your 
machine.

OneCNC 5 Axis Position Machining
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Select the sample file which is most like the machine you will be 
programming for, and save a copy as ‘Tutorial 5 axis position.
ONECNC’.

Open the layers tab to see how 
the part file is arranged.  The layer 
named 3 holds the machine body.  
This is the base layer which does 
not move in the preview mode.  The 
trunnion is on layer 4, and the rotary 
table is on layer 5. 

For the swivel type of machine the 
layer named ‘DMG_AXIS4’ contains 
geometry which defines the swivel 
table axis.

Preview the example toolpath group and observe the full machine 
simulation in action.  The rotary table and trunnion rotate to each 
position as required.
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Define planes

Turn off all layers except the one named Model, and select the 
Isometric view.  We will now prepare to create 5 axis toolpaths on this 
part.

To create toolpaths in a 5 axis position, we define a plane for that 
position, and create toolpaths in 5 axis position mode.  When the 
program is run the machine will rotate to the plane position.

The plane can be in any position in OneCNC but it must be a position 
which can be reached by the machine.

While working on a part it is good practice to save all the planes you 
will need before you start, so you can quickly return to a plane.

If you have suitable surfaces on your 
part, the Plane from surface command 
is convenient for creating the required 
planes.

From the Planes dialog, select the Create 
plane from surface icon.
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Click on the closest end face of the part to create a plane on it.

Open the Planes dialog again, and save 
the plane as End Left.

Create a plane on the trapezoidal face, and save it as Back.

When using the Plane from surface command, the plane created 
may sometimes be red on top, indicating the negative side.  If this 
happens, use the Flip plane command to reverse the orientation of 
the plane.



Page 78 Introduction to OneCNC Mill Multi-axis ©

Rotate the view of the part so you are looking at it from the opposite 
direction.  Define a plane on the right side of the part and name it End 
Right.

Save a plane for the pocketed and drilled face, naming it Top.

Create a plane to face and slot the upper portion of the front of the 
part.  Save this plane as Front upper.
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The last plane required is that required for facing the bevel between 
the upper front and the base of the part.

For a trunnion type machine this can be on the lower surface. Name 
this plane Front lower.

For a swivel table type machine, to mill the lower front face you will 
need a plane perpendicular to the face.

Create a plane on the surface and start the Rotate plane command.  
Rotate the plane with an X tilt of -90.  Use the Move plane command 
to position the origin on a vertex of the upper edge.  Name the plane 
Front lower.
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Prepare boundaries

For some toolpaths you will need geometry boundaries.
Construction geometry may be used, but there will be times when you 
have to create the geometry.

It is good practice to keep the geometry for each plane on a separate 
layer with a corresponding name.  Create 6 new layers and name 
them ‘Boundary Right’, ‘Boundary Left’, ‘Boundary Top’, ‘Boundary 
Front’ and ‘Boundary Back’.

In the plane dialog, select the End Left plane.
Select the Boundary Left layer as the active layer.

Click on the Model Tools icon and select Extract surface edges.

Click on the left end of the part to extract the edges as wireframe 
geometry.

Turn off the Model layer so you can see 
the extracted geometry.

Delete the lines extracted at the end 
of the slot on the upper front face, and 
draw a new line across that corner to 
create a simple boundary for facing.
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Use the surface from curves command 
to create a blanking surface to cover the 
pocket while facing. 

The outer boundary and blanking surface 
will be used for a facing operation, and 
the internal boundary will be used for 
the pocketing operation.

Turn on the Model layer again.
Select the Back plane and the Boundary 
Back layer.

Create a boundary for a facing 
operation.  There is no need for a 
blanking surface.

Select the End Right plane and the 
Boundary Right layer.

Create boundaries and a blanking 
surface for the right end of the part to 
match those for the left end.

     A note regarding extracted geometry
Due to the nature of computer modelling, extracted geometry 
may be segmented.  This is especially true of arcs extracted 
from imported models.  Extracted geometry will be in the correct 
position, but be prepared to trim or redraw as necessary.
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Select the Top plane and the Boundary 
Top layer.

Create boundaries and a blanking 
surface for the top of the part.

Select the Front Upper plane and the 
Boundary Front Upper layer.

Use the Endpoint option of the Universal 
Line command to connect the corners of 
the face to form a boundary.

There is no need for a blanking surface.

For trunnion machines, create a 
boundary on the lower surface for a 
facing operation.  There is no need for a 
blanking surface.

For swivel type machines, you only need to extract the top edge of 
the front lower face, to use for a profile operation.
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5 Axis Position Toolpathing 

Once suitable planes and geometry have been defined, we can begin 
defining the actual toolpaths.

Before continuing, click on the axis mode selection icon in the NC 
Manager toolbar, and select 5 Axis Position Machining.

Create a new toolpath group in the 
NC Manager and name it Practice 
Toolpath Group.

With the ‘Top’ plane active, use the outer boundary and blanking 
surface created earlier to define a Planar Finish toolpath.

Use the 50 MM CARBIDE FACE MILL with 
a Rapid Plane clearance of 50.

The planar cut will have an angle of 0 
and constant stepover of 20.

Use the Pick a boundary option, with 
Normal tool offset.

Clear the Automatic Z Offset check box, 
and set Z Top of Job to 1 and Z Bottom 
Of Job to 0.  This will limit the toolpath 
to the level of the plane.
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Select the blanking surface and click on the Blank icon to hide it.

Create a Z Level roughing operation to 
machine the pocket.  Use the 25 MM 
CARBIDE END MILL.  

Select the Highspeed Closed machining style and Ramp Helix entry.
Enter a 25% stepover with 25mm rough depths.
Use the Picked boundary option, with no tool placement.
Set Z Top Of Job to 0 to force the toolpath below the plane.
Set Z Bottom Of Job to -45.
Select the internal boundary for the toolpath.

Change to the End Right plane and 
boundary layer, and create a Planar 
Finish facing toolpath in the same way 
as the top was done.

Continue creating facing toolpaths 
around the part, selecting planes and 
geometry as required for each face.
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Note that for a swivel table type 
machine, you will have to mill the lower 
front face as a stock toolpath profile 
chain operation.

Activate the plane perpendicular to the 
face, and use an end mill to profile the 
edge at the top of the flat area.

With the ‘End Right’ plane active and 
the facing surface blanked, create a Z 
Level roughing operation to machine 
the pocket on the end of the part.  Use 
the 10 MM 1R HSS BULLNOSE tool.  The 
rest of the settings are similar to the 
pocketing done on the top of the part.

Change planes and use the same 
settings to create the pocket on the 
other end of the part.
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To cut the front slot, define a Z Level 
Rough toolpath with the same boundary 
used for the facing outline.

Use the 6mm carbide end mill and the 
Traditional machining style.

Select Find Flat Areas in the Custom 
Levels dialog to force the toolpath to the 
level at the base of the slot.

Clear the check box for Automatic Z Offset, and set a Z Top Of Job 
value of 0.  The Z Bottom Of Job value can be any number that 
exceeds the depth of the slot, which is 6.375.

The remaining machining is the drilling 
and counterboring of the bolt holes.

Use Hole Feature Recognition to create the bolt hole machining.  You 
can specify all the operations in one Hole Feature definition.

Center Drill the positions, then drill the stem holes 50mm deep with a 
12.7mm diameter drill.

Define a helical Counter Bore operation with a 10mm End Mill.  The 
counterbore is 19.05mm deep with a diameter of 25.4.
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Turn the machine layers back on, and preview the toolpath group you 
have defined.

We have now covered the general methods of 5 axis position 
toolpathing, and you can now go on to programming your own parts.  

Many 5 axis parts look complex at first, but by defining planes and 
boundaries and progressing logically through the machining strategy 
they will usually become a straightforward programming exercise.



Page 88 Introduction to OneCNC Mill Multi-axis ©

This tutorial is intended for OneCNC Mill Expert with the 5 Axis simultaneous 
module activated.

The 5 axis simultaneous mode creates model toolpaths which 
can move up to 5 machine axes at the same time.  When the 
mode is active, the simultaneous toolpaths menu will show 5‌ axis 
simultaneous toolpaths, which are all finish type strategies.

5 axis simultaneous toolpaths are similar to their 3 axis counterparts, 
but the angle of the spindle relative to the Z axis can change when 
necessary to avoid collision of the tool holder with a surface.  This 
enables the cutter to machine areas of the part which a 3 axis 
toolpath could not.

Position planes are not used in the 5 axis simultaneous mode, and the 
current plane should be set to the default XY plane before defining 5 
axis simultaneous toolpaths.

OneCNC 5 Axis Simultaneous
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Even though the underlying computation is very complex, defining 
5 axis simultaneous toolpaths is similar to defining 3 axis model 
toolpaths.

The 5 axis simultaneous mode is entered by selecting it in the 
Multiaxis dialog.

Clicking on the Simultaneous Toolpaths icon in the toolbox will open 
the Simultaneous Toolpaths menu.

The available strategies are:

5 axis Z Level Finish 
5 axis Planar Finish
5 Axis Area Machining
5 Axis Valley Machining
5 Axis Offset 3D
5 axis Pencil Tracing
5 Axis Swarf Cutting
5 axis Radial
5 axis Spiral
5 axis Custom
5 axis Steep Wall
5 axis Shallow



Page 90 Introduction to OneCNC Mill Multi-axis ©

The minimum clearance between the holder and the part is 
maintained automatically.  The Clearances dialog in each toolpath 
wizard gives you the option to add greater clearance if you want more 
for a particular toolpath.

If the surface being machined does not present any obstruction to the 
tool and holder, they will remain vertical.
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Simulate a 5 axis simultaneous toolpath

We will start by simulating a sample file, to see how a 5 axis 
simultaneous toolpath behaves.

Open the sample file ‘mill expert 5 axis 
impeller.ONECNC’, and save a copy of 
the file to practice in.

There is an example toolpath group 
in the NC manager with pre-defined 
operations to machine the part.

The first operation is a 3 axis Z Level 
roughing toolpath to rough out the 
shape.

The rest of the example group 
uses various 5 axis simultaneous 
strategies.  To see one of them in 
action, right click on the first Swarf 
Cutting operation and select Preview 
toolpath from the context menu.
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As the toolpath machines down the shape at each Z level, you will see 
the holder tilting to keep clear of the part.  The default display shows 
the part fixed in place, with the holder moving on all five axes.  With 
this type of motion it is easier to visualize the cutting action.
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If the ‘Show axis simulation’ icon is selected, the fourth and fifth axes 
will be displayed moving the part, indicating the motion you would 
actually see on a machine with rotary table axis movement.

Close the preview window when you are ready to continue
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Prepare for 5 axis simultaneous toolpaths

We will practice 5 axis simultaneous toolpathing by re-creating some 
of the existing operations in a new group.  To save time we can copy 
the Z level roughing operation.

Create a new toolpath group and 
rename it ‘Practice Toolpath Group’.  
Duplicate the Z Level roughing 
operation in the example toolpath 
group, and drag the copy into the 
practice group.

Your NC Manager should now look 
like this.

The multi-axis mode icon should show the 5 axis Simultaneous 
mode is current.

If it is not, click on the icon to open the selection dialog.  Select the 5 
axis Simultaneous mode, and click OK.

Before continuing, check that the XY 
default plane is current.
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5 axis Swarf Cutting - single pass

Click on the Simultaneous Toolpaths icon and select the 5-axis Swarf 
Cutting toolpath.

When you start a swarf cut operation, the first step is to select the 
surfaces to be machined.  To be machined with the side of the tool, 
a surface must be flat, or only curved in one direction.  During the 
surface selection stage, any surfaces with complex curvature will be 
colored black.

In this part the sides of the blades can be swarf cut, but the fillets and 
surfaces between the blades have complex curvature which makes 
them unsuitable for Swarf Cutting.

Select the right side of the nearest blade, and right click to end the 
selection stage.

Note:
For this operation we are only machining one surface.  You can 
select more than one surface for a swarf cutting operation but the 
surfaces must be a single contiguous set.
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When the Select Tool dialog appears, select a 5mm carbide ball mill 
from the Tool Library.

The holder associated with this tool is not suitable for a 5 axis 
simultaneous toolpath.

The defined holder is used by OneCNC to determine the position and 
angle of the holder during the toolpath.  The holder must be defined 
accurately, so that clearance between the holder and part is calculated 
correctly.

Click on the Holder name to open the Holder dialog.
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Click on the ‘new’ button below the holder list, to add a new holder 
to the holder list.  Select the new holder listing, and select the Edit 
holder check box to define the holder, naming it CAT 40 LONG TAPER.

Enter a holder height of 100 and radius of 20.  Select the 40 CAT/BT/
SK holder size.  Enter 0 for Flange clearance and 5 for Total holder 
clearance.  It is absolutely essential to have the holder clearance 
defined correctly. 

Select the check box for Tapered section and enter a Taper height of 
100 with Bottom radius of 10.  Leave the Machine Head check box 
empty, and click OK to return to the Select Tool dialog.
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Change the tool Flute Length to 30.

Enter Tool number 2, and set Coolant to No1 and Work Offset to G54.

Enter 210 for the feedrate and the plunge rate will update to 105.

Set the spindle speed at 17570.

Select Ball Center for Tool Zero Position.

Click Next to continue.
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Set the Start and Finish clearance to 250 and Rapid Z plane at 30, 
with a Plunge clearance of 10.

Click Next to continue.
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We do not need multiple passes to machine this surface, so we can 
select Single Cut in the Entry and Path Settings dialog.

Select Climb Milling and click Next to continue.
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Enter 0 for Extend Amount as we do not want the tool to cut past the 
blade surface.

Enter 0.005 for Tolerance.

Enter 0 for Leave for finish.

Select Start at Corner for the Start Position.

Click Next to continue.

Note:

If you are Swarf Cutting multiple surfaces that form a loop you 
can select Start at mid to have the toolpath start midway along a 
surface.
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Select Line for Leadin style.

Set Leadin Length to 8 and Leadin Angle to 0.

Click the copy icon to copy the Leadin values to the Leadout settings.

Click Finished, and the toolpath will be created.
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Backplot the toolpath to see the result.  The angles of the plunge and 
retract lines in the backplot show that this is a 5 axis simultaneous 
operation.

5 axis Swarf Cutting - multiple passes

We have just defined a toolpath which machines the surface in a 
single pass.  To see how it can be machined in multiple passes, create 
a duplicate of the toolpath and edit it.

Select Cut Levels and enter Depth of cut 10 in the Entry and Path 
Settings dialog.

Backplot the edited toolpath and you will see the multiple passes at 
increasing increments across the surface.
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5 axis simultaneous Area Machining

The next toolpath we will define is an Area Machining toolpath to 
finish the surface between the blades.

Click on the Simultaneous Toolpaths icon and select the 5-axis Area 
Machining strategy.

Select the surfaces between the blades, including the fillets.

Right click to end the selection stage.

The Select Tool dialog will open.
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Select the 5mm ballnose cutter in the CAT 40 Long Taper holder which 
was used for the Swarf Cutting toolpath.

Enter Tool number 2, and set Coolant to No1 and Work Offset to G54.

Enter 210 for the feedrate and the plunge rate will update to 105.

Set the spindle speed at 17570.

Select Ball Center for Tool Zero Position.

Click Next to continue.
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Set the Start and Finish clearance to 150.
Set the Rapid Z plane at 100, with a Plunge clearance of 5.

Click Next to continue.
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The next dialog controls how the tool is angled relative to the part 
as it travels along the toolpath.  The Dynamic option tilts the tool 
automatically, but you can set a preferred angle that will be used if 
possible.

Select the Preferred Angle + Around X0 Y0 option, and enter a 
preferred angle of 20.

The preferred angle setting will maintain the orientation of the tool as 
close to 20° from vertical as possible.

The around X0 Y0 option will keep the tool oriented towards X0 Y0 so 
it will always be in a radial position relative to the part.
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Enter a Stepover value of 1, and 0 for Leave for finish.
Enter 0.005 for Surface Tolerance.
Select Climb Milling for Direction of Cut.
Select the Spiral Outwards Path Style.

Click Finished and the tooolpath will be created.
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Preview the Area Machining toolpath and you will see that the 
preferred angle is maintained until the tool approaches the blade.

Once interference with the model is detected the tool will tilt to avoid 
the blade.
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Practicing 5 axis simultaneous toolpaths

In this tutorial we covered 5 axis Swarf Cutting and 5 axis Area 
Machining.

The remaining 5 axis simultaneous toolpath strategies are all defined 
in a similar way to their 3 axis counterparts.

You can create simple models to practice these toolpaths so that you 
become familiar with their use.

By doing this you will be confident in their application when you need 
to use them.

More information about Multi axis toolpaths is available in the ‘Mill 
Multi Axis Machining’ section under ‘OneCNC Mill’ in OneCNC Help.
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For assistance contact the OneCNC office for your location.

If you are emailing a support question, it will help us to help you if 
you zip and attach the file you are having a problem with, and include 
the following information:

Client Number
Click on Help > About OneCNC.  Your client number is a five digit 
number with the prefix CN. The number is the same as your dongle 
number.

Version
Click on Help > About OneCNC to find the exact version you are 
running, e.g. 62.79

OneCNC product
The type and level of OneCNC such as Mill Expert.

Units
Please let us know if the file is drawn in metric or imperial units.

OneCNC Support
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Australia
				   OneCNC Australia

		  Phone 		  +61 (0)7 3286 2527
		  Fax 		  +61 (0)7 3286 4992
		  Email		  support@onecnc.com.au
		  Internet	 www.onecnc.com.au 

Benelux
				   OneCNC Benelux

		  Phone		  +31 (0) 40 22 66 212
		  Fax		  +31 (0) 40 22 40 794
		  Email		  support@onecnc.nl
		  Internet	 www.onecnc.nl 

Denmark
				   OneCNC Denmark

		  Phone		  + 45 20 40 02 68
		  Fax		  + 45 20 40 02 68
		  Email		  support@onecnc.dk
		  Internet	 www.onecnc.dk  

France
				   OneCNC France

		  Phone		  + 33 (0)4 72 33 38 74
		  Fax		  + 33 (0)4 72 91 42 92
		  Email		  support@onecnc.fr
		  Internet	 www.onecnc.fr

Germany
				   OneCNC Germany

		  Phone		  +49(0)5261 288940
		  Fax		  +49(0)5261 2889449
		  Email		  support@onecnc.de
		  Internet	 www.onecnc.de

India
				   OneCNC India

		  Phone		  +61 7 3286 2527
		  Email		  support@onecnc.com.au
		  Internet	 www.onecnc.in

Indonesia
				   OneCNC Indonesia

		  Phone		  +62 31 8411187
		  Email		  support@onecnc.id
		  Internet	 www.onecnc.co.id

OneCNC Global Offices
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Ireland
				   OneCNC Ireland 

		  Phone		  +353 7196 33200
		  Fax		  +353 7196 33500
		  Email		  support@onecnc.co.uk
		  Internet	 www.onecnc.co.uk 

Italy
				   OneCNC Italy

		  Phone		  +39 393 438 3373
		  Fax		  +39 178 271 6215
		  Email		  support@onecnc.it
		  Internet	 www.onecnc.it

Japan
				   OneCNC Japan

		  Phone		  +81 (0)72 760 3134
		  Fax		  +81 (0)72 760 3135
		  Email		  onecnc@onecnc.co.jp
		  Internet	 www.onecnc.co.jp 

Korea
				   OneCNC Korea

		  Phone		  + 82 31 695 7250
		  Fax		  + 82 31 695 7253
		  Email		  support@onecnc.kr
		  Internet	 www.onecnc.kr

Mexico
				   OneCNC Mexico

		  Phone		  +52 (55) 85017429
		  Email		  esanchez@onecnc.com.mx
		  Internet	 www.onecnc.com.mx 

Portugal
				   OneCNC Iberia 

		  Phone		  +34 936 473 117
		  Email		  josep.soler@1cnc.es
		  Internet	 www.onecnc.es

Poland
				   OneCNC Poland

		  Phone		  +48(0)22 388 3460
		  Fax		  +48(0)22 388 3461
		  Email		  support@onecnc.pl
		  Internet	 www.onecnc.pl
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South Africa
				   OneCNC South Africa 

		  Phone		  +27 31 7014732
		  Fax		  +27 31 7014736
		  Email		  sredman@iafrica.com
		  Internet	 www.onecnc.net

Spain
				   OneCNC Iberia 

		  Phone		  +34 936 473 117
		  Email		  josep.soler@1cnc.es
		  Internet	 www.onecnc.es

Sweden
				   OneCNC Sweden

		  Phone		  +46 (0)35-7777030
		  Fax		  +46 (0)35-7777031
		  Email		  support@onecnc.se
		  Internet	 www.onecnc.se

Taiwan
				   OneCNC Taiwan

		  Phone		  + 886 2 26665010
		  Fax		  + 886 2 26660917
		  Email		  chou@wvision.asia
		  Internet	 www.onecnc.com.tw

United Kingdom
				   OneCNC UK

		  Phone 		  +44 (0) 190 237 3054 
		  Fax 		  +44 (0) 190 237 5593
		  Email		  support@onecnc.co.uk
		  Internet	 www.onecnc.co.uk

USA
				   OneCNC LLC

		  Toll Free	 +1 877 626 1262
		  Phone		  +1 813 874 2335
		  Fax		  +1 813 874 2919
		  Email		  support@onecnc.com
		  Internet 	 www.onecnc.com 

USA California
				   OneCNC West

		  Phone		  +1 909 931 7811
		  Fax		  +1 909 985 6967
		  Email		  support@onecncwest.com
		  Internet 	 www.onecncwest.com 
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